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Administering IP/TV Store and 
Replay Server

This chapter describes how to administer the Store and Replay feature of IP/TV Server. 
Topics covered include:

• Store and Replay concepts and application scenarios

• Store and Replay modes

• Using the Store and Replay feature

• About Store and Replay windows

• Viewing status and statistical information

Overview
IP/TV Server has an integrated Store and Replay Server that enables storing, replaying, and 
forwarding of Cisco audio/video .rtp streams in the IP/TV network.

If the source is from a local live-capture program, the IP/TV Store and Replay Server will 
write the file into an .mpg format instead of an .rtp format.

The Store and Replay function enables recording of live broadcasts at remote LANs for 
later viewing. One application of this function is allowing viewers from different time 
zones the flexibility to view programs or to repeat a live event when it is suitable. 

The Forward function uses a multicast tunneling capability called SmallCast. Using the 
SmallCast feature, IP/TV software can operate across a WAN, where some portions of the 
network are not upgraded with IP multicast capability.
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Overview
Generally, you will not use the Store and Replay Server directly. IP/TV Server invokes the 
Store and Replay Server automatically when scheduled to do so by the Content Manager. 
However, you will need to run the Store and Replay Server directly to preview .rtp files or 
to manually carry out the Replay and Forward functions. 

After an .rtp file has been recorded, the file can be made available as an on-demand program 
or file session through the Content Manager.

Concepts
The Store and Replay Server receives or transmits multimedia streams on the network. It 
may store .rtp data in an .rtp file, replay the file locally, or serve it to the network. These 
streams are usually generated by one of the other components of the IP/TV Server. The 
streams may be MPEG audio and video, H.261, MPEG4, or any of the audio and video 
formats that Cisco Systems supports. In all of these cases audio and video streams are sent 
using an industry standard protocol called .rtp (RTTP). The Store and Replay Server stores 
or forwards these streams immediately by multicast, or it may be used to replay the stored 
streams later.

Network Source
A network video or audio source is an .rtp stream received over the network. 

Store and Replay
Storing (recording) a program consists of saving incoming live or network multimedia 
streams to a local disk. You can schedule a recording by indicating specific times using the 
Content Manager or you can spontaneously record while the program is being received (just 
like one would with a VCR).

Replaying a program consists of sending a locally stored .rtp file to the network.

SmallCast
SmallCast is designed for intranet and Internet environments in which one or more of the 
routes is not multicast-enabled. SmallCasting allows a multimedia session to be forwarded 
across one or more nonmulticast-enabled routers (or across the Internet) as a unicast 
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Application Scenarios
transmission. Then it is multicast to viewers on the remote network segment or it can simply 
be viewed by a single IP/TV viewer. See the “SmallCasting Scheduled Programs” chapter 
for more information about SmallCast.

Application Scenarios
This section contains four example scenarios (cases) in which IP/TV Servers in remote 
offices or workgroups can use Store and Replay and/or SmallCast to distribute multimedia 
content. For all cases, see Figure 9-1.

Case 1: Multicast with Local Storage
This case provides viewing time flexibility for geographically remote office LANs. The 
remote IP/TV Server stores .rtp streams received via multicast while headquarters viewers 
are watching the program in real time. Source viewers at the remote site can watch the 
program in real time while others may view a scheduled rebroadcast or on-demand program 
later.

Case 2: SmallCast
This case shows how to reach remote office LANs connected through older network 
segments. The remote IP/TV Server receives unicast streams over the nonmulticast WAN 
and then remulticasts the streams to the local LAN for real-time viewing.

Case 3: SmallCast with Simultaneous Local Storage
This case shows how the remote IP/TV Server simultaneously stores an incoming 
SmallCast stream (sent via a unicast address) for later replay and remulticasts the content 
to the LAN for real-time viewing. 

Case 4: Standalone Viewer
This case shows how a standalone remote user can receive a unicast stream from 
headquarters over the WAN and view the video in real time without having an IP/TV Server 
installed. 
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Overview
Figure 9-1 Example Application Scenerios
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About Store and Replay Modes
About Store and Replay Modes
There are two modes of using the Store and Replay feature: Server mode and Manual mode.

The Server mode is the normal way to use the Store and Replay Server. You set up a Store 
and Replay Server program for storing (recording), replaying, and forwarding using the 
Content Manager. The Store and Replay Server is automatically started by the IP/TV Server 
when scheduled to do so by the Content Manager. Refer to the IP/TV Content Manager 
User Guide for additional information.

Use the Manual mode when the Content Manager may not be available, or when you want 
to replay or forward previously stored or incoming .rtp streams on an unscheduled basis. 

Using the Store and Replay Server
This section discusses how to use the Server and Manual modes of the Store and Replay 
functions. It also describes how to manually preview a local .rtp file. 

Storing (Recording)
The Store feature records incoming media streams to a .rtp file. It can record one video, one 
audio, and one SlideCast stream simultaneously, or any combination thereof.

Note Web Presenter programs are not recordable.

When the IP/TV Server requests the Store and Replay Server to record, the Store and 
Replay Server is automatically launched by the IP/TV Server.

To schedule the Content Manager to record a program and save it as an .rtp file, follow 
instructions in the “Recording Scheduled Programs,” section in the IP/TV Content Manager 
User Guide.
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Using the Store and Replay Server
Reserving Disk Space
The Store and Replay Server allows a certain amount of reserve disk space that it will not 
touch while recording an .rtp or .mpg file. The default reserve space is 20 MB. You can 
increase or decrease this amount by entering the following into the IPTV.ini file:

[RTP Files]
reserve=n

[MPEG Files]
reserve=n

where n is the size in megabytes if followed by an M, gigabytes if followed by a G, and 
bytes if followed by a K. For example, 40M, 1G, and 200K are 40 megabytes, 1 gigabyte, 
and 200 kilobytes, respectively.

When you record an .rtp or .mpg five, the maximum size is 4 GB by default. You can reduce 
or increase the size by entering the following into the IPTV.ini file:

[RTP Files]
maxfilesize=n

[MPEG Files]
maxfilesize=n

where n is a size in megabytes if followed by an M, or gigabytes if followed by a G.

Note A typical MPEG1 video stream with MPEG audio will consume about 12 MB per 
minute.

Replaying
The Replay feature plays a recorded program from an .rtp file and sends the stored data to 
the network. The replay program will be identical to the original program as it was received 
by the recording server which means that if any data is lost by the network then the quality 
of the recording and the retransmission will reflect the loss.

The replay of an .rtp file normally is controlled by a program created in the Content 
Manager. The Store and Replay Server is automatically launched by the IP/TV Server and 
given a .svr file containing the program definition. However, you can copy the created .svr 
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Replaying
file and later open it manually in IP/TV Server. Note that the .svr file is only available while 
the replay is active. See the “Replaying Using Server Mode” and “Replaying Using Manual 
Mode” sections later in this chapter.

Replaying Using Server Mode
To schedule the Content Manager to replay an .rtp file to the network, follow the 
instructions in the “Managing IP/TV Programs” section in Chapter 4 of the IP/TV Content 
Manager User Guide.

Replaying Using Manual Mode
Follow these steps to manually replay a recording to the network without a Content 
Manager:

Step 1 Open the .svr file you want to replay to the network in any text editor. 

Note Refer to the sample .sdp file that follows. The corresponding .svr file that is used by 
the source server is identical to this sample .sdp file, except it does not have the backchannel 
attribute.

Step 2 Specify the name of the .rtp file you want to replay next to the file: and filespec: 
attributes.

Step 3 Start IP/TV Server and click Open on the File menu.

Step 4 Select the .svr file you want to replay to the network.

Previewing a Stored .rtp File
To preview a stored .rtp file, open the .rtp file directly, or start .rtp File Viewer by clicking 
Start>Cisco IP/TV>RTP File Viewer. Then, click Open on the File menu and select the 
.rpt file.
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Using the Store and Replay Server
Replaying a Stored .rtp File From Offset
To replay a video clip from a stored .rtp file, note the start and end times in the File Time 
field of the video clip you are viewing in the RTP File Server window. The start and end 
times are displayed in hours, minutes, and seconds (in the format hh.mm.ss). You can 
reposition the video using the Slider bar to obtain your video clip.

Then in the Content Manager, create or edit the program and go to the Edit Program 
window. Enter the start and end times in the Play from Offset field.

SmallCasting
The Store and Replay Server SmallCast function sends a program in unicast mode from a 
source server to another Store and Replay Server on the network. The receiving Store and 
Replay Server forwards the program in multicast mode.

The SmallCast function is used when programs are transmitted to remote multicast enabled 
networks through links that do not support multicast. If the remote network is a single LAN 
segment it does not need to support multicast.

When invoked by the IP/TV Server, the Store and Replay Server creates a .sdp file which 
defines a forwarding program. Note that the .sdp file is the same file type used by the 
Viewer. However, in the case of the forwarding program, additional instructions in the file 
tell the forwarder to re-transmit the program to a set of multicast addresses (one for each 
media: video, audio, and SlideCast).

Note The Show Preview command is disabled on the forwarding server. Performance 
problems may occur on many systems if you are locally viewing and forwarding 
simultaneously.

SmallCasting Using Server Mode
You can schedule the Content Manager to SmallCast a program by following the 
instructions in the “Setting Content Manager Defaults and Preferences,” sections in the 
“Setting Up IP/TV Content Manager” chapter.
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SmallCasting
You can configure the Store and Replay component of IP/TV Server, using the Content 
Manager, to SmallCast programs with the following options:

• SmallCast with multicast

• SmallCast with no multicast

The Use SmallCast option instructs the source server to unicast the program to all of the 
servers specified in the server’s SmallCast list (limit of seven), and if the SmallCast Only 
option is not checked, multicast the program using the IP address specified in the Multicast 
Address Information section of the New Program page.

The SmallCast Only option instructs the source server to only unicast the program to the 
servers specified in its SmallCast list. If this check box is turned on, the program will not 
be multicast. This option only applies if the Use SmallCast option is turned on. 

SmallCasting Using Manual Mode
Follow these steps to manually view and forward an incoming media stream to another 
server:

Step 1 Open the .sdp file and edit in any text editor. Refer to the sample .sdp file in the 
“Sample .sdp File” section later in this chapter.

Step 2 Specify the server or servers you want to forward to in the forward attribute 
and the backchannel address in the backchannel attribute. Then save and close 
the file.

The lines that are specific to forwarding are:

a1=backchannel:204.162.119.80

a3=forward:only 204.162.119.80 204.162.116.97 204.162.119.106

On the backchannel line the address is the same as the first address on the 
forward line. This is the source server that is sending the unicast stream to the 
forwarder.
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Using the Store and Replay Server
The addresses of the forwarding servers are the second through the nth address 
on the forward line. The only keyword on the forward line tells the source server 
not to multicast at that end of the link (only unicast to 204.162.116.97 and 
204.162.119.106 in this case). If you do want to multicast at the source server, 
then delete the only keyword. 

The multicast addresses to use are in their usual place on the cvideo and caudio 
lines.

If you hand edit .sdp or .svr files, you must be aware that you can insert or 
remove attributes, but the attribute numbers must be contiguous starting from 1 
so that there is not a gap in the numbering. For example, if you remove the 
backchannel attribute in order to convert this .sdp file into a .svr file, you should 
change it to something similar to a1=removed instead of deleting the line. It is 
acceptable to have an unrecognized attribute. If you insert an attribute, you can 
put it at the end of the file. Make sure that the new number is the previous last 
number plus 1.

Step 3 Start the IP/TV Server and click Open on the File menu.

Step 4 Select the .sdp file (see Example 9-1).
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SmallCasting
Example 9-1 Sample .sdp File

[programs]
LaunchPrograms=1
[Launch Program]
o=- LaunchProgram 4 IN IP4 204.162.119.80
i=Continuous file session for commercial test.
s=Lobby’s cont. file
a1=backchannel : 204.162.119.80
a2=filespec: 1 name e:\video\sample.mpg
a3=forward: only 204.162.119.80.204.162.116.97.204.162.119.106
a4=video rtpmap: 96 WBIH/90000
mvideo=video 53006 RTP/AVP 31 32 96
cvideo=IN IP4 239.255.203.1/15
a5=video source:video 204.162.119.80 file loop 1
a6=audio rtpmap: 96 L8/22050/2
a7= audio rtpmap: 97 L8/22050
a8=audio rtpmap: 98 L8/22050/2
a9=audio rtpmap: 99 L8/11025
a10=audio rtpmap100 L16/22050/2
a11=audio rtpmap: 101 L16/22050
a12=audio rtpmap: 102 L16/11025/2
a13=audio rtpmap: 103 L1611025
maudio=audio 22058 RTP/AVP 0 14 3 5 96 97 98 99 100 101 102 103
caudio=IN IP4 239.255.195.237/15
a14=audio source: audio 204.162.119.80 file loop 1
a15=framerate: 24
a16=bandwidth: 1150
a17=quality: 7
a18=SuppressErrorMessages: 0
a19:DoSlideShow: 0
a20=copyright:
a21=file: e\video\sample.mpg
a22=channel: QA’s Lobby
t=1 1
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About Store and Replay Server Windows
About Store and Replay Server Windows
This section describes the Store and Replay windows, window tools, and menu items. The 
Store and Replay Server windows display information about selected programs. There are 
two Store and Replay Server windows:

• A Server Program Details window. This window displays the status of scheduled and 
on-demand programs that are currently transmitting media streams from .rtp files to the 
network, or programs that are currently recording incoming media streams to a .rtp file, 
or manually launched programs serving .svr files that reference .rtp files.

• An RTP File Viewer window. This window allows you to locally preview .rtp files. 

Server Program Details Window
To open the Server Program Details window, double-click a program in the IP/TV Server 
Program Listings window, or right click the program and click Program Details.

Figure 9-2 shows an example of the Server Program Details window while serving a .rtp 
file for a replay of a prerecorded program scheduled through the Content Manager.
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Server Program Details Window Menu Commands
Figure 9-2 Server Program Details Window

Server Program Details Window Menu Commands
 describes the menu commands available on the Server Program Details window menu bar.

Table 9-1 Server Program Details Window Menu Commands 

Menu Command Description

File Switch to Program 
Listings

Switch to the Program Listings window.

Close Closes the currently open Server Program Details window. 
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About Store and Replay Server Windows
Server Program Details Window Tools
Table 9-2 describes control buttons and icons on the Server Program Details window.

Video Play Performs the same as the play function of the Play/Pause 
button.

Pause Performs the same as the pause function of the Play/Pause 
button. 

Stop Stops the currently open program or .rtp file.

Record Program Performs the same as the record start function of the 
Record Start/Pause button. (Record session only.)

Pause Recording Performs the same as the pause recording function of the 
Record Start/Pause button. (Record session only.)

Show Preview Toggles between displaying or hiding the preview window. 

Window Always On Top Displays the Server Program Details window on top of any 
other open windows.

Stats Window Displays the Statistics window. See the “Statistics 
Windows” section later in this chapter.

Help Contents Displays online help table of contents.

Using Help Provides information about using Windows Help.

Table 9-2 Server Program Details Window Tools 

Icon Tool Description

Play/
Pause 
button

Plays the current program. This button toggles to pause a 
program.

Pause/
Play 
button

Pauses the current program. This button toggles to 
resume playing a program.

Table 9-1 Server Program Details Window Menu Commands  (continued)

Menu Command Description
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Server Program Details Statistical Information
Server Program Details Statistical Information
This section describes the Server Program Details window status and statistical 
information. See Figure 9-2 for all items described in the following sections.

Program Status Items
When a program is playing, serving, or recording, a program status item is displayed. When 
recording, the program status item Recording Program is also displayed. A separate item 
indicates whether the recording is active, and the name of the .rtp file that is capturing the 
recorded data.

Stop 
button

Stops the program that is currently playing.

Record 
Start/
Pause 
button

Toggles between start recording and pause recording. 
When recording is active, the button is yellow. When 
recording has paused, the button is green.

Slider 
bar

Allows you to adjust the position while serving a 
prerecorded .rtp file. The number at the right end is the 
Total File Time. 

Progress 
bar

Indicates the completion progress of a scheduled 
recording or while serving a prerecorded .rtp file. For 
continuous replay or forwarding, the bar just indicates 
activity. For continuous replay, the bar indicates progress 
through the recorded .rtp file. For a one time replay, the 
progress bar and slider bar track each other.

Table 9-2 Server Program Details Window Tools  (continued)

Icon Tool Description
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Server Program Details Statistical Information
Program Statistics
Table 9-3 lists and describes the overall program statistics.

Table 9-3 Program Statistics

Statistics Windows
Click Window>Stats Window to open the audio and video Statistics windows. These 
lower-level protocol statistics windows contain information provided by Cisco System’s 
MSock layer. MSock stands for Multimedia Sockets and is Cisco System’s implementation 
of the RTP/RTCP protocol.

Statistic Description

Frame Rate This is the video frame rate as represented in the data 
stream that is either being served from a recorded file, or 
received for recording or forwarding. When recording, 
this rate is the same as the original capture frame rate 
unless the network is heavily loaded and many packets 
are being lost. This situation usually does not last long 
unless there is a serious network problem.

Data Rate Indicates, in bits per second, the sum of both audio and 
video data (and also SlideCast if present).

Duration Indicates the total elapsed time since the program was 
opened.

Current File Time The File Time will advance, indicating the current offset 
in the file.

Countdown Indicates the amount of time remaining in the file. 

Total File Time Indicates the size of the file in time. It increases while 
recording a file. 
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Statistics Windows
Figure 9-3 shows an example of the Server Program Details Audio Statistics window.

Figure 9-3 Server Program Details Audio Statistics Window
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RTP File Viewer Window
RTP File Viewer Window
To open the RTP File Viewer window, click Start>Program Files>Cisco IP/TV 
Server>RTP File Viewer. Go to Open in the window menu and select a .rtp file. You can 
also double-click an .rtp file to open the window and file simultaneously.

Figure 9-4 shows an example of the RTP File Viewer preview window for a prerecorded 
.rtp file.

Figure 9-4 RTP File Viewer Window
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RTP File Viewer Window Menu Commands
RTP File Viewer Window Menu Commands
Table 9-4 describes the menu commands available on the RTP File Viewer window menu 
bar.

Table 9-4 RTP File Viewer Window Menu Commands

Menu Command Description

File Open Opens a RTP file.

Close Closes the currently open program or .rtp file. 

Recent File Reopens the most recently opened .rpt file.

Exit Exits the RTP File Viewer window.

Video Play Performs the same as the play function of the Play/Pause 
button.

Pause Performs the same as the pause function of the Play/Pause 
button. 

Window Always On Top Displays the RTP File Viewer window on top of any other 
open windows.

Stream Statistics Displays the Stream Statistics window. See the “Stream 
Statistics Window” section later in this chapter.

Help Contents Displays online help table of contents.

Using Help Provides information about using Windows Help.

About RTP Server Displays version information.
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RTP File Viewer Window
RTP File Viewer Window Icons and Buttons
Table 9-5 describes icons and buttons on the RTP File Viewer window.

Table 9-5 RTP File Viewer Window Tools

Icons Buttons Description

Play/
Pause 
button

Plays the current program. This button toggles to pause a 
program.

Pause/
Play 
button

Pauses the current program. This button toggles to 
resume playing a program.

Stop 
button

Stops the program that is currently playing.

Slider 
bar

Allows you to adjust the position while serving a 
prerecorded .rtp file. The number at the right end is the 
Total File Time. 

Progress 
bar

Indicates the completion progress while previewing a 
prerecorded .rtp file. The progress bar and the slider bar 
track each other.
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Stream Statistics Window
Stream Statistics Window
The Stream Statistics window shows the activity of up to three streams of audio, video, and 
SlideCast for the .rtp file you are previewing. 

To open the Stream Statistics window, in the RTP File Viewer window click 
Windows>Stream Statistics.

Figure 9-5 shows an example of the Stream Statistics window.

Figure 9-5 Stream Statistics Window

Information displayed in the window is as follows:

• Data Bytes: The accumulated number of bytes sent up to the present time.

• Total ADUs: The total number of application data units.

• Rate: The data rate in bits per second.

• Packets Lost: The accumulated number of lost packets (based on observing the .rtp 
sequence numbers).

• Peak Rate: The maximum instantaneous rate in bits per second during the transmission 
(since the program was opened).
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